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 Introduction to PowerPoint 

 
PowerPoint is a program that creates presentations or slide shows.  Some things to note about it 
are as follows: 

• File Format – the file extension for PowerPoint presentations is (.pptx).     
• What is a PowerPoint Presentation – A typical PowerPoint presentation is a slide show 

composed of slides.  Slides may contain text, pictures, movies, or be blank.     

The PowerPoint Interface 
PowerPoint has an interface similar to other Microsoft applications, so you should see 
similarities in the menus such as Home, Insert, View, etc.  There are 4 areas within the 
PowerPoint window.  They are pictured as follows: 
 

 

 

 
 

Slide Outline 
This shows a list of all the 
slides in your presentation.  
This window runs along the 
left side of the screen. 

Slide Design Area 
This is the area where you 
will create your slides.  
Prompts help guide you (e.g., 
“Click to add title”). 

Editing Menus 
Clicking on the menu 
choices opens up visual 
selections to choose from. 

Notes Area  
Use this area to add personal 
notes to a slide.  These notes can 
be printed so that you can refer 
to them during a presentation.   

 

 

Some important things to note about slides are as follows: 
• PowerPoint provides you with slide templates.  All you need to do is choose the style 

for your slide and enter text.   
• Typically, there are text boxes on the slide template.  Click into these boxes and type 

text. The fonts and font sizes for these boxes are preset.  You do not need to change 
them.  However, if you add more text than a text box can hold, PowerPoint will, by 
default, use an “Autofit” feature to shrink the text and make it fit the text box. 
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• Some slides have more than one text box.  You do not have to use all of the text 
boxes; delete them if you do not use them.  The “Click to add text” prompt will not 
appear in your slide show when you actually play it for an audience 
. 

Creating Your First Presentation 
1. Open PowerPoint from either your desktop or your Start menu. 
2. When PowerPoint opens, you are given a blank slide by default.  This slide is formatted by 

default to be your title slide. 
3. Enter a title for your presentation.  Click into the top text box and type your title.   Changing 

fonts, color, etc. is just like word processing.  Highlight the text, then use the menus at top to 
change.  However, you will find that PowerPoint does a great job selecting default fonts, etc. 
for you, so typically you won’t need to change them. 

4. Enter a sub-title if you wish.  If you do not enter a subtitle the words “click to add subtitle” 
will NOT appear in your slide show.  You can also delete the text boxes you don’t use. 

5. Add another slide to your presentation.  Select Home  New Slide.   The format for this 
slide is “Title and Text.” 

6. To choose from all possible slide layouts.  Select Home  Layout.  All possible slide 
formats are shown in this area.  If you do not like the current slide layout, explore this pane 
for another layout.  To change the format of your slide, click once onto the desired layout in 
the Task Pane.  The new layout will automatically appear within the slide you are currently 
working on. 

 
 

7. Continue adding slides as needed.  Choose different slide layouts from the task pane. 
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Moving Around within Your Presentation 
Along the left side of the screen, you are given an outline view of your presentation; all slides are 
listed in numeric order.   

 
 
This column is called the Slide Outline.  If you select any of the slides in this window, you will 
be able to “jump” to the slide you selected.  That slide will appear in the main window for you to 
view and edit. 
  
For example, if you are currently viewing the 5th slide in your presentation and you want to go 
back to the first, click onto the first slide in the outline list of slides.  You will see the first slide 
appear immediately within the main window. 
 

Editing, Copying, Moving and Deleting Slides 
To edit an Existing Slide, do the following: 

1. Find the slide you want to edit within the Slide Outline.  Click onto the slide you want to 
edit.  The slide you selected should now appear within the Slide Design Area. 

2. Click into the text boxes to change the text on the slide. 
 
Sometimes it is easier to copy and edit a slide that has a lot of formatting than to recreate and 
reformat a new slide.     
 
To copy a slide, do the following: 

1. From the Slide Outline on the left side of the screen, select the slide you want to copy by 
clicking on it. 

2. Go to Home and click on the down arrow that appears just below New Slide.  
3. You will see a list of default slides, very much like the slide layout options.  At the very 

bottom, of this window are three additional options. 
4. Select Duplicate Selected Slides.  A duplicate slide is inserted and ready to be edited 
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To move a slide to a new position in the slide show, do the following: 
1. From the Slide Outline on the left side of the screen, click on the slide you want to move. 

When you click, do not let go of the mouse button 
2. Drag the slide up or down to its new position, holding the mouse button down.  You will 

see a line above the pointer that indicates the new position of the slide. 
3. When the slide is in the position you want it, let go of the mouse button. 

 
To delete a slide, do the following: 

1. From the Slide Outline on the left side of the screen, click on the slide you want to delete. 
2. Go to Home  Delete. 

 

Adding Transitions to a Presentation 
 
Slide transitions refer to the way slides move from one to another and are an easy way to make 
your presentation look polished and professional.  Typically, it is best to apply the same 
transition to all slides.  To apply a transition to your presentation, do the following: 

1. Click on Animations.  
2. The transition menu opens.  There are pictures representing various options and more can 

be found by using the tiny scroll bar to the right of the last transition icon.  Click the 
transition effect you want.  A preview of the transition will play in the slide pane. 
 

 
 

3. Use the settings to the right to adjust Transition Speed or to apply the selected transition 
to all slides.  NOTE:  We recommend using fades or nothing (known as a cut) to avoid 
making your audience dizzy.  Most ‘fancy’ transitions are distracting and don’t really add 
much.  We also recommend against adding any sound – for the same reason. 

 
Note: By default, slides are set to by default to move forward a slide on “mouse click”.  
Change this only if you are setting up a self playing kiosk or interactive presentation. 

 

Viewing your Presentation 
After you have finished creating your presentation, you are ready to view it.  There is a 
difference between creating and editing your slides in PowerPoint and viewing the presentation 
as a slide show.  Thus far, you have been creating slides.  When you view a presentation as a 
slide show, you leave PowerPoint and enter show mode.  After exiting show mode, you are 
returned to PowerPoint. 
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To view your presentation as a slide show, do the following: 

1. Go to Slide Show  From Beginning OR press F5. 
2. Your presentation will now appear as a series of slides in a show. 
3. Use the arrows on the keyboard to move through the slides.   

a. Press the up arrow to move forward. 
b. Press the down arrow to move backward. 

4. When you are done viewing your presentation, press the Escape key on your keyboard to 
return to PowerPoint edit mode. 

5. If you want to go to a black slide without ending the presentation (you may wish to 
expound on a point during your presentation), press the ‘b’ key on your keyboard.  This 
key works as a toggle.  Press it again to return to your slideshow. 

 
Tip: To start your presentation at a point other than the beginning, click on the slide you wish to 
begin at and then click on Slide Show  From Current Slide.  
 
Be sure to practice viewing your PowerPoint files so that you feel comfortable moving through 
the slides while you speak. 
 

Saving Your Presentation 
To save your presentation, do the following: 

1. Go to the Office Button  Save As. 
2. If you want others to be able to use this in an older version of PowerPoint, choose Choose 

PowerPoint 97-2003 (not everyone can view a 2007 PowerPoint).  Otherwise, choose a 
PowerPoint Presentation.  

a. PowerPoint 2007 has the file extension .pptx 
b. PowerPoint 97-2003 has the file extension ppt.  

3. Choose a location to save your file and enter a name for in within the “File name” area.  
Note: It is best to save your presentation in its own folder along with copies of any 
images or supporting files you may have used in the presentation.  

 
Note: There are other options for saving but those options will not be discussed here. 

Adding a Design Template  
Design Templates help to add ready-made visual design to your presentation.  They provide your 
entire presentation with colors, fonts, and bulleting, etc. following traditional design rules.  
PowerPoint comes loaded with templates for you to choose from.  Since most of us aren’t artists, 
using them is probably a good idea. 
 
To use a select a design template, do the following: 

1. Click Design. 
2. In the Task Pane, you will see all of the available design templates in PowerPoint.   
3. Choose a Template by double-clicking onto it.  You will notice that all of your slides are 

now using that template.   
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4. If you ever want to change the template design, go back to Design and select another 
template from the template list.  Note:  The first one in the list is blank (white background 
with black text). 

 
 

The color scheme of any template can 
be modified by clicking on the 
“Colors” link in the Design Menu. 

 
If you prefer something simple, do 
not change the template.  Instead,  
Go to Design  Background Styles 
 Format Background.  Here you 
can choose a color and/or pattern for 
your background and apply it to all 
slides in your presentation. 
  

 

Applying / Removing Bullets and Indentation 
By default, text in PowerPoint is bulleted. Text that is indented from the bullet point above it will 
automatically formatted with a different bullet than the text above it.  PowerPoint Design 
Templates determine the look and color of bullets for up to five levels of text. 
           

 

To add or remove a bullet, click 
into the line of text where you 
want the bullet applied/removed 
and click on the bullet button on 
the formatting toolbar.   

To change your bulleted list to a 
numbered list, click on the 
numbered bullet button on the 
formatting toolbar 

    

 

To indent or demote text to 
the next level, click on the 
increase indent button   

To remove and indent or 
promote text, click on the 
decrease indent button in 
the formatting toolbar 

Advanced:  Animating Text 
Controlling the timing of the appearance of text on a slide allows you to direct your audience’s 
attention and prevents them from reading ahead while you speak.  PowerPoint uses a feature 
called “Custom Animation” to give you precise control over when and how your text lines 
appear on screen.   BE CAREFUL:  Animating individual lines of text can be wearing on your 
audience… 

1. Click on the slide you want to animate. 
2. Click on the text box you want to apply an animation to. 
3. Go to Slide Animations  Custom Animations. 
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4. In Custom Animation task pane that appears on the right, click on Add Effect  
Entrance (choose effect from list) 
 

Advanced:  Adding Images to your Presentation 
To insert an image into your presentation, do the following: 

1. Insert or apply a slide from the slide layout task pane that includes a placeholder for a 
picture. 

2. Go to Insert  Picture 
3. The My Pictures directory on your computer will open.   
4. Select a picture and click Insert. 
5. The picture editing toolbar will open.   

a. To resize, click and drag on the handles (round white circles) on the picture.  If 
you don’t these white circles, click once in the middle of the picture to ‘select’ it. 

b. To move the picture, click on the middle of the picture and drag it or, if the 
picture is selected, use the arrows keys to move it. 

c. You can use the various other tools in the picture tool menu to crop the picture, 
add borders, etc. 

d. When you are finished editing the picture, click Compress Picture.  Compressing 
pictures ensures that your PowerPoint presentation doesn’t become a huge file 
(pictures can be many, many megabytes each). 

 
You can use the other options in the Insert menu to add charts, shapes, clip art – even an entire 
ready-made photo album.   
 

Options for Printing Your Presentation 

Printing from within PowerPoint 
To print your presentation, do the following: 

1. Go to the Office Button  Print. 
2. You now have to specify what you want to print.  Here are your choices:  

• Slides – print one slide per page.  Avoid this, as it uses a lot of paper. 
• Handouts – print your slides into handouts.  You can choose to have up to six slides 

per page.  You can also select the order the slides are presented on the page.  

 
Printing Handouts from a presentation   

 
Tip:  If you select 3 slides per page, PowerPoint automatically prints three slides 
vertically with lines to the right of the slide for your audience or class to take notes 
during your presentation.  This is the only print layout that does this. 
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• Notes Pages – if you decide to add notes to your slides, you can opt to print these out 

and refer to them while presenting (try not to read them word for word).   
• Outline View – print your slides in outline format with the title of the slide and each 

bulleted point listed below. If you have used images in your presentation, they will 
not be included.  Outline view can be a helpful tool for memorizing your presentation 
narrative. 

 

Creating Handouts in Microsoft Word 
To bypass PowerPoint’s printing restrictions (such as 1 slide 
per page, or only getting blank lines for note taking with the 
three slide handout layout) You can send your PowerPoint 
presentation to Microsoft word for printing.  To do this: 
 

1. Go to Office Button  Publish  Create Handouts 
in Microsoft Word.  

2. A window opens displaying several options. 
3. Choose the layout that you want. 
4. Microsoft Word opens with your document ready to 

edit and print.  
 

Printing on a Macintosh 
 

1. Go to File  Print.  A small window opens. 
2. From the Print What section of the form, select the drop-down menu.  
 

 

 

               The Handouts Menu 
 

3. Select the Handouts option with the number of slides you want. 
4. Click Print to finish. 

 
 

Online Quick Reference Guide  
http://www.customguide.com/pdf/powerpoint-quick-reference-2007.pdf 

http://www.customguide.com/pdf/powerpoint-quick-reference-2007.pdf�
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Frequently Asked Questions 
 
Does PowerPoint have a spellchecker? 
Yes.  It is located under the Review menu. 
 
How can I keep my text from resizing as I type? 
Turn off text AutoFit (this is on by default). When resizing is turned off, Microsoft PowerPoint 
will not reduce your font size and line spacing to fit spillover text into a placeholder. 

1. Go to Office Button and select PowerPoint Options. 
2. Click AutoCorrect Options.  
3. Click the AutoFormat As You Type tab.  
4. Under Apply as you type, do any of the following:  

• To turn off AutoFit for title text, clear the AutoFit title text to placeholder check box.  
• To turn off AutoFit for body text, deselect the AutoFit body text to placeholder.  

 
I have text AutoFit on, but my title text is not fitting to one line. 
When title text resizing is on, title text is reduced by one font size level to bring spillover text 
onto one line. If the title text is too long, one reduction in font size might not bring all the text to 
one line, and text will spill over to the next line. In this case, you would have to shorten the title.  
 
 I have text AutoFit on, but text in my text box doesn't resize to fit as I type. 
Text AutoFit applies to placeholder text only— title text and body text such as bulleted lists. It 
doesn't apply to text boxes, AutoShapes, or WordArt. 
 
Is there a way to make global changes (such as changing fonts or bullets) to the Design 
Template so that I don’t have to edit every slide individually? 
Use the Slide Master, which controls the defaults in your Slide Design Template, including fonts, 
bullets, color, sizes, etc.  To access the Master Slide, go to View  Slide Master.  The topmost 
slide in the outline view is the master for all slides and editing it will change all slides in your 
slideshow.   There is also one master for each slide layout style (e.g., title slide).   
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How do I make each line of multi-level text appear individually on click, instead of having 
text grouped? 
By default, when you click into a text box and apply an entrance animation, PowerPoint will 
have level one text and all sublevels of that text appear at the same time.  To adjust this, apply 
the animation and then do the following: 
 

1. Click on the drop down arrow next to the first effect. 
2. Select Effect Options. 
3.  In the effect options dialog box, click on the third tab, 

Text Animation. 
4. Select the highest level of text in your text box. 
5. Click OK. 

 
 
 

 

Strategies for Using PowerPoint in the Classroom 
 
• In Conjunction with Clickers 

Clickers are handheld polling devices.  You post a question with multiple possible answers in 
PowerPoint and students use clickers to enter their answer.  The software tallies the answers 
and displays it immediately.  Used anonymously, this is a great way to find out if they ‘got it’ 
right then and there, stimulate discussion, and create an engaging environment.   

 
• Play Music to Set the Mood for Learning 

An excellent way to set the mood for learning in the classroom is to play music in the 

 

To make global changes to your 
slides, select the portion of the 
master slide (Slide Title, Text 
levels, bullets, etc) and reformat as 
desired.   
 
To apply the changes and return to 
working on your slideshow, click 
on the Close Master View. 
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background as students enter.  This can help settle down large classes prior to the start of 
your instruction. 
 

• Get Your Students Thinking.  Display a Question at the Beginning of Class. 
When students begin shuffling into class, one way to get them prepared to interact with your 
materials is to display a question at the front of the room.  Go even further and invite them to 
speak about the question with a classmate and prepare to share their thoughts with the class. 
 

• Combine PowerPoint Presentation with In-Class Activities 
Instead of showing an entire PowerPoint presentation straight through, pause it from time to 
time to do active, in-class activities and exercises.  Then return to the presentation. 

 
• Offer Fill-in-the-Blank Slides on Blackboard and Ask Students to Bring Them to Class 

to Finish.  
If you opt to leave certain text areas on the slides blank, students will need to attend and 
participate in lecture in order to complete their notes. 

 
• Compare and Contrast 

Ask your students to take a survey on Blackboard.  Use PowerPoint to compare and contrast 
their results with some other data group (e.g., national).  Discuss the differences with your 
students. 

 
• Use Branching Presentations to Allow Students to Steer Conversation. 

Give students a choice to decide which topic they would like to discuss in class.  A branching 
presentation will give you the ability to jump to different locations within a presentation.   

 
• Create Interactive Games 

It is possible to create highly interactive question and answer games in PowerPoint.  Check 
out The PowerPoint Parade of Games website at http://facstaff.uww.edu/jonesd/games/  This 
website has downloadable samples and templates of interactive games available for 
instructors. 

Instructional Technology at the University of Hartford 
 
 
Faculty Center for Learning Development 
FCLD provides consulting and support to faculty interested in incorporating technology into 
instruction.  FCLD has a faculty lab equipped with instructional technology and available for 
faculty use. 
Telephone:  768-4661 
Email:  fcld@hartford.edu                        Website:  http://uhaweb.hartford.edu/fcld 
 
 
Information Technology Services:   

http://facstaff.uww.edu/jonesd/games/�
mailto:fcld@hartford.edu�
http://uhaweb.hartford.edu/fcld�
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ITS Help Desk 
Contact the ITS Help Desk for general computer and Internet/network support questions ITS 
Help Desk (technology not directly related to the classroom but rather passwords, Internet/email 
problems, printer not working, banner, facebook, grades). 
Telephone: 768-5999 
Email:   its@hartford.edu                         Website:  http://uhaweb.hartford.edu/its/ 
 
Media Technology Services 
MTS is a department devoted to fulfilling equipment requests and the integration of technology 
into classes. Faculty may request additional equipment to be delivered to classroom.   
Telephone:  Main 768-4643 
Email:  mts@hartford.edu                         Website:  www.hartford.edu/mts 
 

mailto:its@hartford.edu�
http://uhaweb.hartford.edu/its/�
mailto:mts@hartford.edu�
http://www.hartford.edu/mts�
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